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About this document...

Getting Started with Mona  is an example based tutorial designed to get you up and
running on Mona in a minimum amount of time.  It is not a user's guide, and does 
not describe all features of the Mona software.

This tutorial uses a simple RLC circuit to demonstrate how to:

• Launch the Mona application.
• Create a new circuit using the schematic editor.
• Obtain node voltages and branch currents in symbolic or numeric form.
• Obtain and manipulate a circuit's frequency response.
• Plot a circuit's output response over time.

The estimated time required to complete this tutorial is 30 minutes.
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Getting Started

1.  Insert the Mona Demo disk in your disk drive and launch the Mona application 
by double clicking on the Mona icon.  (For better performance, you may wish to 
copy the entire disk to a new folder on your hard drive before launching the 
application.)

2.  A dialog box will appear such as that shown below.  Select "ElecComp2" by 
double clicking on that choice.
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Mona  is  a  powerful  tool  with  applicability  to  a  wide  range  of
engineering fields.  The component template file provides the means
to  customize  Mona  with  symbols  and  terms  suitable  to  different
environments.

3.  Wait a moment and a new window will appear.

Using the Schematic Editor

In Mona, you specify circuits the same way you normally visualize them:  using a 
schematic diagram.  In this section, we create a series RLC circuit using the 
schematic editor.

☞  Component Placement

4.  Position the mouse anywhere in the new window (we will refer to this window 
as the drawing area).  While holding down the  key, press and hold the mouse ⌘
button.  A palette of circuit components will appear under the current mouse 
position (see Figure 3).  Once the palette appears, release the  key.⌘

Figure 3: The component palette

Selection Tool, Directed wiring Tool, Wiring tool

Voltage source, Current source, Impedance

Resistor, Capacitor, Inductor

Adder, Multiplier, Positive terminal

Opamp - infinite gain, Opamp - finite gain, Negative terminal

Voltage controlled voltage source, Current controlled voltage
source, Voltage source
Voltage controlled current source, Current controlled current
source, Ground
Text annotation tool, Short circuit

5.  Without releasing the mouse button, select the voltage source by moving the 
mouse pointer over that symbol.  Once the mouse pointer is positioned over the 
voltage source symbol, release the mouse button.  Note that the palette will 
disappear and the appearance of the mouse pointer will change to indicate that 
an element is selected. 
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6.  Now place the voltage source in the drawing area by holding down the mouse 
button and dragging the mouse pointer downwards and to the left.  An outline 
box will "rubber-band" with the pointer.  Once this box is visible, release the 
mouse button.  An independent voltage source will appear in the drawing area.
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7.  Repeat steps 4-6 to place a resistor, an inductor, a capacitor, and a ground 

symbol in the drawing area.  Lay out these components as shown in Figure 4 
below.

Tips from the pros...

• for dependent sources, a short circuit or positive and 
negative terminals must be drawn before the source.

• To reposition the label of a component, select the 
component first, then press the Option key and     
click and drag the label to its new position.

• To edit a label, first select the component then click on 
the label to edit it.
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☞  Component Rotation

8.  Your circuit will look better if you rotate the inductor by 90 degrees.  To do this,
follow these steps:

• Click on the inductor; a selection box will appear around the inductor.
• Under the Misc menu, select the Transform sub-menu.  Select Rotate 90˚.

Your circuit diagram should now appear as shown in Figure 5.

Tips from the pros...

Mona has many other useful features for making your circuit schematics
look just right.   You can drag and drop elements, cut and paste, annotate
your diagram with text, align elements relative to one another, and much
more.  Many of these features are quite intuitive.  Others you'll find by
browsing through the menu items.  And of course, there are a few that
you won't discover until you read the user's guide!   You might want to
take a moment to experiment with some of these now - the Edit menu is a
good place to start.
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☞  Wiring

9.  Select the WIRE element from the component palette just as you selected the 
voltage source and other elements in steps 4 and 5.

10. Position the mouse pointer over the small circle on the positive terminal of the 
voltage source.

11. Press and hold the mouse button and move the mouse pointer upwards.  Note 
that wire now trails the mouse pointer.

12. When the mouse pointer is roughly horizontal with the resistor, release the 
mouse button.  A fixed segment of wire should extend from the voltage source to
the position at which the mouse button was released and wire should still trail 
the mouse pointer.

13. Position the pointer over the small circle on the near terminal of the resistor.  
Single click the mouse button.  Wire should now extend from the voltage source 
to the resistor.  Wire should no longer trail the mouse pointer.  (If it does, try 
clicking again on the resistor terminal.)

Repeat steps 9 through 13 - summarized in Figure 6 - to connect the remaining 
elements in series.  Don't forget to connect the ground symbol to the negative 
terminal of the voltage source.  Your completed circuit should look similar to that 
shown in Figure 7.
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Tips from the pros...

• Remember:  Wire from terminal to terminal.  Wire is used to connect
circuit elements, so each segment of wire must begin and end on element
terminals.

• If you need to put more than one "bend" in a wire, just single click at
each point where you want a bend.

• Make sure you connect a ground symbol to your circuit.  Mona will
need it to provide a voltage reference.
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Circuit Analysis

Rather than providing a lot of fancy analysis tools that perform specific tasks 
"automatically", Mona concentrates on the fundamentals:  determining node 
voltages and branch currents.  

Using  these  tools,  ordinary  circuit  components,  and  a  little  thought,
practically all other circuit parameters can be determined.  For instance,
to find the input impedance, you can change the input to a 1 A current
source and measure the voltage across the input terminals (setting all
independent sources to zero).

☞  Preparations

15.  Select Analyze Circuit from the Mona menu.  This updates the circuit node 
voltages and branch currents and must be repeated whenever the circuit 
schematic is modified.

☞  Symbolic Node Voltage

16.  Using the mouse, click on the wire between the resistor and inductor, as shown
in Figure 8.  Note that selection corners will appear on the ends and corners of 
the wire once it is properly selected.

17.  To determine the voltage at this node, select Node Voltage from the Mona 
menu.  A new window - the Console window - will appear.  The requested 
voltage will be displayed in the Console window.

Note that the mathematical expression for the voltage is entirely 
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symbolic.  Practically all other commercial circuit analysis programs 
force the user to associate fixed numeric values with each component 
before performing any analysis.   Mona provides the general solution in 
terms of the names assigned to the circuit components.
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☞  Symbolic Branch Current

18. Using the mouse, click on a circuit element such as the resistor.  A selection 
box will surround the element as shown in Figure 9.

19. Select Branch Current from the Mona menu.  Another result will be 
displayed in the Console window, as shown in Figure 10.
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Frequency Domain Analysis

20.  Under the Window menu, select Graph & Bode Window.  A new window 
will appear on top of your circuit diagram window such as that shown in Figure 
11.  We will use this window to obtain a frequency domain plot of V2.

☞  Setting Variables

Note that the variables queried earlier - V2 and I2 - have been automatically added 
to the Variables list, along with all of the variables that they reference: Vs1, R1, 
L1, C1, and s.  In order to graph V2 over a range of frequencies (a range of s=jw), 
we will need to assign fixed numeric values to Vs1, R1, L1, and C1.

To assign a value to a variable, follow these steps, as indicated in Figure 12:

• Select the variable to be modified by clicking on its name in the Variables 
list.
• Enter the new value for the variable - units are not required - in the input box.
• Click on the Set Var button in the main command bar.

Tips from the pros:

• Instead  of  clicking  on  the  Set  Var button,  you  can  simply  hit  the
RETURN key once the value is entered.  This is usually faster.

• You can use the standard metric prefixes and exponential notation when
specifying values.  For instance, all of the following are equivalent:

4700
4.7k
4.7E3
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21.  Set Vs1, R1, L1, and C1 to the values shown below:

• Vs1 = 1 V
• R1 = 3.3 kΩ
• L1 = 3000 H
• C1 = 1μF

22.  To see the value associated with a variable, simply double-click on that 
variable in the Variables list.  For example, to examineV2, double click on the 
V2 choice in the Variables list, as shown in Figure 13.  Note that Mona has 
substituted the values for Vs1, R1, L1, and C1 into the expression associated 
with V2.  If your V2 is different from that shown in Figure 13, make sure that 
you have set Vs1, R1, L1, and C1 correctly as indicated above.
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☞  Plotting a Graph

23.  To plot a graph of V2 over the current frequency range, ensure that V2 is the 
currently selected variable in the Variables list, and click on the graph button, as
shown in Figure 14.  A frequency response graph similar to that of Figure 15 will
be plotted.
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Tips from the pros...

• The default style for this graph is that of a Bode diagram:  magnitude
in dB (20log(V2)),  phase in degrees,  and frequency in radians/s on a
logarithmic scale.  You can reconfigure many of these parameters with a
little experimentation, if you wish.

• The plotting functions are quite generic and may be used to plot any
univariate function.  For example, if you developed an equation for the
voltage characteristics of a capacitor, C = f(V), you could plot the C-V
characteristics. 

26.  You can make this plot look better by changing the axes to "zoom in" on the 
interesting part.  Single clicking with the mouse pointer over any axis will bring 
up a dialog box which will allow you to change the range of that axis (see Figure
16).  For this plot, you might want to try the following settings:

• Magnitude: -60 dB to 30 dB
• Phase: -180 degrees to 180 degrees
• Frequency:1 rad/s to 10 rad/s
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Note that you'll have to click on the graph button to replot the graph after you 
have changed the frequency range.  The resulting graph should look  similar to 
that shown in Figure 17.
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☞  Parameter Variation

27.  Double click on the R1 variable and note its current value (3.3K).  Change the 
value to 33K using the same procedure you used in step 21 above.

28.  Double click on the V2 variable and note that the new value of R1 has been 
substituted into V2.  Plot this new expression for V2 by clicking on the graph 
button.  Your plot should look similar to that shown in Figure 18.  Feel free to 
experiment with other values for R1 and the other circuit components.

This "graphical  equation manipulation" environment is one of Mona's
greatest  strengths.   It  encourages  "what  if"  analysis  and  shows  the
relationship  between  parameter  values,  transfer  function  expressions,
and the resulting graphs.   Up to four functions can be plotted on the
same graph.
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The numbers in the graph can be dragged around, just click and drag on
the solid dot.
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Time Domain Analysis

To obtain a graph of the time domain response of a variable, you first create a new 
time domain variable, and then plot a graph of that variable.

Important note:  The remainder of this tutorial uses the original component 
values:

• Vs1 = 1 V
• R1 = 3.3 kΩ
• L1 = 3000 H
• C1 = 1μF

If you've changed some of these values (such as R1), you should change them back
now.

☞  Generating a Time Domain Function

29.  Ensure that V2 is the current variable and select the F(t) button from the main 
command bar, as shown in Figure 19.  This will create a new variable, V2_t, 
corresponding to the Inverse Laplace transform of V2 (see Figure 20).  
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☞  Preparing to Plot

Mona maintains two independent graphing windows, each with its own domain, 
range, and other preferences.  This allows you to keep two different "sets" of 
graphs.  Usually, this feature is used to separate frequency domain plots from time 
domain plots, and the default preferences for each have been set accordingly.

30.  Change to the time domain graph set by clicking on the Time toggle switch, as 
indicated in Figure 21. 

31.  Click on the vertical axis.  A dialog box will appear, allowing you to modify 
the range of the graph.  Change the range to {-2 V to +2 V} and click on OK.
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☞  Plotting a Graph

32.  Ensure that V2_t  is the current variable and click on the graph button.  The 
time response will be plotted as shown in Figure 22.
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Bode Diagram Approximation and Design

Bode diagram approximation is an important concept often taught in 
electrical engineering undergraduate courses.  Frequency domain design is 
performed using standard piecewise linear "building blocks" which 
approximate the contribution of particular poles and zeros in the s-domain 
function.

☞  Preparations

33.  Return to the frequency domain graph set, as shown in Figure 23.

34.  Remove any existing plots using the Clear Graph button, as shown in Figure 
24.

35.  Since this section of the tutorial isn't concerned with the RLC circuit we 
looked at earlier, you should delete those old variables.  Simply select V2 from 
the variables list and click on Del var.  V2 should be removed from the list of 
variables, along with any variables that it references (unless another variable also
references those variables).  Repeat this procedure for I2 and V2_t.  Nothing 
should remain in the list of variables.
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Tips from the pros...

A faster way of deleting all variables is to select Init variables from the
Variables pop-up menu (above the list of variables).

36.  We will need some room for our design, so change the magnitude range to { -
60 dB to 60 dB } and the frequency range to { 1E-1 to 1E6 }.
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37.  Although it is important to recognize that each building block has both a 
characteristic magnitude and a characteristic phase response, we have chosen to 
suppress the phase information in the screen shots that follow, to simplify the 
presentation.  In order to obtain the same graphs, you will need to click on the 
Show C2 check box.  When you do this, the phase axis should disappear.

☞  Bode Diagram Design

There are four building blocks, corresponding to:  a pole at the origin, a zero at the 
origin, a pole away from the origin, and a zero away from the origin.  The 
corresponding piecewise linear effect on the magnitude and phase plots is depicted 
by the buttons in the Bode diagram design palette located below the graph window.

38.  Select the "zero away from the origin" button, as shown in Figure 25.

39.  Move the mouse pointer into the graph window, approximately over the 10^2 
frequency, and single click the mouse button.  This should introduce a magnitude
increase of 20 dB/decade, beginning at the frequency where the mouse was 
clicked, as shown in Figure 26.
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40.  Select the "pole away from the origin" button, as shown in Figure 27.

41.  Move the mouse pointer into the graph window, approximately over the 10^3 
frequency, and single click the mouse button.  This should introduce a magnitude
decrease of 20 dB/decade, beginning at the frequency where the mouse was 
clicked, as shown in Figure 28.
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☞  Equation Manipulation

Approximations are useful tools, but it is always important to keep in mind their 
limitations.  What is the actual s-domain expression ?  Mona will provide you with 
the actual expression and even plot the approximation and real functions side by 
side.

42.  You will need to create a new variable to associate with the new expression 
you are about to retrieve.  Enter a new variable name in the variable input area, 
and click on the New var button, as shown in Figure 29.

Tips from the pros...

• corner points can be moved by clicking and dragging.

• corner points can be deleted by shift clicking.

• graphs can be dragged vertically by clicking and 
dragging on a line segment.
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• graphs can be dragged horizontallu by shift clicking and 
dragging on a line segment.



GETTING STARTED WITH MONA 31

43.  Click on the Get eqn button, as shown in Figure 30.  This copies the 
expression corresponding to the Bode diagram approximation into the input area.

44.  Ensure that your new variable name is selected, and click on Set Var.  This 
associates the expression with a particular variable.
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45.  Plot the new variable by clicking on the graph button.  Results are shown in 
Figure 31.
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This  completes  the  Getting  Started  With  Mona tutorial.   Feel  free  to
continue to experiment with this demonstration copy of Mona, using your
own circuits or those provided in the Sample Files  folder.  When you are
finished, select Quit from the File menu.


